
 

 

 

 

 

 

Agilent 5100 ICP-OES 

 

 

User’s Guide 
 



2 Agilent 5100 ICP-OES User’s Guide 

Notices 

© Agilent Technologies, Inc. 2014 

No part of this manual may be 

reproduced in any form or by any 

means (including electronic storage 

and retrieval or translation into a 

foreign language) without prior 

agreement and written consent from 

Agilent Technologies, Inc. as governed 

by United States and international 

copyright laws. 

Manual Part Number 

G8010-90002 

Edition 

First edition, June 2014 

Printed in Malaysia 

Agilent Technologies, Australia (M) 

Pty Ltd 

679 Springvale Road 

Mulgrave, Victoria, 3170 

Australia 

Warranty 

The material contained in this 

document is provided “as is,” and is 

subject to being changed, without 

notice, in future editions. Further, to 

the maximum extent permitted by 

applicable law, Agilent disclaims all 

warranties, either express or implied, 

with regard to this manual and any 

information contained herein, 

including but not limited to the 

implied warranties of merchantability 

and fitness for a particular purpose. 

Agilent shall not be liable for errors 

or for incidental or consequential 

damages in connection with the 

furnishing, use, or performance of 

this document or of any information 

contained herein. Should Agilent and 

the user have a separate written 

agreement with warranty terms 

covering the material in this 

document that conflict with these 

terms, the warranty terms in the 

separate agreement shall control. 

Technology Licenses 

The hardware and/or software 

described in this document are 

furnished under a license and may be 

used or copied only in accordance 

with the terms of such license. 

Restricted Rights Legend 

If software is for use in the 

performance of a U.S. Government 

prime contract or subcontract, 

Software is delivered and licensed as 

“Commercial computer software” as 

defined in DFAR 252.227-7014 (June 

1995), or as a “commercial item” as 

defined in FAR 2.101(a) or as 

“Restricted computer software” as 

defined in FAR 52.227-19 (June 1987) 

or any equivalent agency regulation or 

contract clause. Use, duplication or 

disclosure of Software is subject to 

Agilent Technologies’ standard 

commercial license terms, and non-

DOD Departments and Agencies of the 

U.S. Government will receive no 

greater than Restricted Rights as 

defined in FAR 52.227-19(c)(1-2) (June 

1987). U.S. Government users will 

receive no greater than Limited Rights 

as defined in FAR 52.227-14 (June 

1987) or DFAR 252.227-7015 (b)(2) 

(November 1995), as applicable in any 

technical data. 

Safety Notices 

A CAUTION notice denotes a hazard. 

It calls attention to an operating 

procedure, practice, or the like that, if 

not correctly performed or adhered to, 

could result in damage to the product 

or loss of important data. Do not 

proceed beyond a CAUTION notice 

until the indicated conditions are fully 

understood and met. 

A WARNING notice denotes a 

hazard. It calls attention to an 

operating procedure, practice, or the 

like that, if not correctly performed or 

adhered to, could result in personal 

injury or death. Do not proceed 

beyond a WARNING notice until the 
indicated conditions are fully 

understood and met. 

WARNING 

CAUTION 
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General 

Operation of an Agilent 5100 Inductively Coupled Plasma-Optical 
Emission Spectrometer (ICP-OES) involves the use of compressed 
gases, high voltage radio frequency energy and hazardous materials 
including corrosive fluids and flammable liquids. Careless, improper 
or unskilled use of this spectrometer or chemicals used with it can 
cause death or serious injury to personnel, and/or severe damage to 
equipment and property. Only trained personnel should use this 
instrument. 

The spectrometer incorporates interlocks and covers that are 
designed to prevent inadvertent contact with any potential hazards. 
If the instrument is used in any manner not specified by Agilent, this 
protection provided by the equipment may be impaired. It is good 
practice to develop safe working habits that do not depend upon the 
correct operation of the interlocks for safe operation. It is essential 
that no interlock or cover is bypassed, damaged or removed. 
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The safety practices described below are provided to help the user 
operate the instrument safely. Read each safety topic thoroughly 
before attempting to operate the instrument and always operate the 
spectrometer in accordance with these safety practices. 

Plasma 

The plasma is extremely hot (about 10,000 °C) and radiates 
dangerous levels of radio frequency (RF) and ultraviolet (UV) energy. 
The work coil operates at 1,500 V RMS and about 27 MHz. Exposure 
to the RF and UV energy can cause severe skin damage and cataracts 
of the eyes, while close contact with the operating plasma can result 
in severe heat burns to the skin, and an electrical discharge that can 
jump a considerable distance and may cause death, severe electric 
shock or sub-surface skin burns. 

The plasma must never be operated unless:  

 the plasma compartment door is closed, with the door handle 
fully closed; and 

 the space above the chimney and air intake is clear of objects. 

The shielding around the torch compartment is designed to reduce 
UV, visible and RF radiation to safe levels while still permitting easy 
access to, as well as installation and viewing of, the torch. The 
spectrometer has an interlock system that is designed to extinguish 
the plasma if the mains supply fails, the handle on the torch 
compartment door is opened, or the torch loading handle is open. Do 
not attempt to bypass the interlock system. 

Before opening the torch compartment door, always extinguish the 
plasma by pressing SHIFT + F5 on the keyboard or by clicking the 
‘Plasma Off’ icon on the ICP Expert software toolbar. 

The torch and its surroundings remain hot for up to five minutes 
after the plasma is extinguished. Touching this area before it has 
cooled sufficiently may result in burns. Allow the torch and torch 
compartment to cool before carrying out any work in this area, or 
wear heat-resistant gloves. 
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The plasma system has been carefully designed to operate safely and 
effectively when using torches and related components that conform 
to Agilent’s design criteria. Use of non-approved components in the 
plasma compartment may render the system inoperative and/or 
hazardous. It may also invalidate the warranty on the instrument. 
Use only torches and related components supplied or authorized by 
Agilent. 

Heat, Vapors and Fumes 

Heat, ozone, vapors and fumes generated by the plasma can be 
hazardous, and must be extracted from the instrument by means of 
an exhaust system. Ensure that an exhaust system of the appropriate 
type is fitted (as specified in the Site Preparation Guide). The system 
must be vented to the outside air in accordance with local regulations 
and never within the building. Regularly check the exhaust system by 
smoke test to ensure that the exhaust system is functioning correctly. 
The exhaust system must always be switched on before igniting the 
plasma. 

Compressed Gas Hazards 

All compressed gases (other than air) can create a hazard if they leak 
into the atmosphere. Even small leaks in gas supply systems can be 
dangerous. Any leak (except that of air or oxygen) can result in an 
oxygen-deficient atmosphere, which can cause asphyxiation. The 
area in which cylinders are stored and the area surrounding the 
instrument must be adequately ventilated to prevent such gas 
accumulations. 

Gas cylinders must be stored and handled strictly in accordance with 
local safety codes and regulations. Cylinders must be used and stored 
only in a vertical position and secured to an immovable structure or 
a properly constructed cylinder stand. Move cylinders only by 
securing them to a properly constructed trolley. 

Use only approved regulator and hose connectors (refer to the gas 
supplier’s instructions). Keep gas cylinders cool and properly 
labeled. (All cylinders are fitted with a pressure relief device that will 
rupture and empty the cylinder if the internal pressure is raised 
above the safe limit by excessive temperatures.) Ensure that you have 
the correct gas before connecting it to the instrument. 
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The primary gas used with the spectrometer is argon, which is the 
conductive gas for the plasma. Argon or nitrogen can be used as the 
polychromator purge gas. Other gases may be required for future 
options and accessories. Use only ‘instrument grade’ gases with your 
spectrometer. 

If using cryogenic gases (for example, liquid argon), prevent severe 
burns by wearing suitable protective clothing and gloves. 

Electrical Hazards 

The spectrometer system and some accessories contain electrical 
circuits, devices and components operating at dangerous voltages. 
Contact with these circuits, devices and components can cause death, 
serious injury or painful electric shock. Panels or covers which are 
retained by screws on the spectrometer and accessories may be 
opened only by Agilent­trained, Agilent-qualified or Agilent­approved 
field service engineers (unless specified otherwise). Consult the 
manuals or product labels supplied with your personal computer 
(PC), monitor, printer and water-cooling system to determine which 
parts of those systems are operator-accessible.  

Connecting the Agilent 5100 to a power source that is not equipped 
with a protective earth contact creates a shock hazard for the 
operator and can damage the instrument. Likewise, interrupting the 
protective conductor inside or outside the Agilent 5100 or defeating 
the power cord ground creates a shock hazard for the operator and 
can damage the instrument. 

Other Precautions 

Use of the spectrometer system and accessories may involve 
materials, solvents and solutions which are flammable, corrosive, 
toxic or otherwise hazardous. Careless, improper or unskilled use of 
such materials, solvents and solutions can create explosion hazards, 
chemical burn hazards, fire hazards, toxicity and other hazards that 
can result in death, serious personal injury or damage to equipment. 
Apply all necessary precautions including use of lab coats, safety 
goggles and other appropriate forms of personal protection. All 
wastes should be disposed of in accordance with local regulatory 
requirements. 
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Operation of an ICP-OES involves analysis of solutions that have 
been prepared in or digested with acids, or in some cases, samples 
that have been prepared in organic solvents.  

The acid concentration in the sample that is measured varies, 
depending upon the digestion steps and acid types used. Instrument 
users should be aware of the hazards associated with use of the acids 
used for sample preparation and apply all necessary precautions 
including use of lab coats, safety goggles and other appropriate forms 
of personal protection. The acid wastes should be disposed of in 
accordance with local regulatory requirements. 

The type, volatility and concentration of the organic solvents used in 
the sample that is measured varies, depending upon the selected 
solvent and the sample preparation involved. Instrument users 
should be aware of the hazards associated with use of the organic 
solvents for sample preparation, and apply all necessary precautions 
including ensuring adequate ventilation during use, and use of lab 
coats, safety goggles, gloves and other appropriate forms of personal 
protection. The organic wastes should be disposed of in accordance 
with local regulatory requirements. 

Air flow to the air intake port of the spectrometer and accessories 
must be unobstructed. Do not block the ventilation grills on the 
spectrometer and accessories. Consult the manuals supplied with 
your PC, monitor, printer and water-cooling system for their specific 
ventilation requirements. 

Great care should be taken when working with glass or quartz parts 
to prevent breakage and cuts. This is especially important when 
inserting the nebulizer into the spraychamber, or removing and 
replacing pieces of broken torch. 

The spectrometer weighs approximately 106 kg (234 lb). To avoid 
injury to personnel or damage to the instrument or property, always 
use suitable mechanical lifting device to move the instrument. 

Use only Agilent-supplied or approved spares with your instrument. 
Only trained operators should use the instrument. 
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Warning Symbols 

The following is a list of symbols that appear in conjunction with 
warnings in this manual and on the spectrometer. The hazard they 
describe is also shown. The beginning of the warning text is noted by 
a warning icon: 

WARNING 

A triangular symbol indicates a warning. The meanings of the 
symbols that may appear alongside warnings in the documentation 
or on the instrument itself are as follows: 

 

Broken glass 

 

Chemical hazard 

 

Electrical shock 

 

Extreme cold hazard 

 

Eye hazard 

 

Fire hazard 

 

Heavy weight 

(danger to feet) 

 

Heavy weight 

(danger to hands) 

 

Hot surface 

 

Noxious gases 
 

RF radiation 
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The following symbol may be used on warning labels attached to the 
instrument. When you see this symbol, refer to the relevant operation 
or service manual for the correct procedure referred to by that 
warning label. 

 

The following symbols appear on the instrument for your 
information. 

I Mains power on 

0 Mains power off 

 Single phase alternating current 

 

Protective ground terminal. 

 
Socket for Agilent accessory serial cable  

 
Socket for Ethernet LAN cable 

 
Socket for Agilent accessory USB cable 

 

Indication of correct orientation of gas filter flow direction 
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CE Compliance 

Your Agilent 5100 ICP-OES instrument has been designed to comply 
with the requirements of the Electromagnetic Compatibility (EMC) 
Directive and the Machinery Directive (MD) of the European Union. 
Agilent has confirmed that each product complies with the relevant 
Directives by testing a prototype against the prescribed EN 
(European Norm) standards. 

Proof that a product complies with these directives is indicated by: 

 the CE Marking appearing on the rear of the product, and 

 the documentation package that accompanies the product 
containing a copy of the Declaration of Conformity. The 
Declaration of Conformity is the legal declaration by Agilent that 
the product complies with the directives listed above, and shows 
the EN standards to which the product was tested to 
demonstrate compliance.  

Electromagnetic Compatibility 

EN55011/CISPR11 

Group 1 ISM equipment: group 1 contains all Industrial, Scientific 
and Medical (ISM) equipment in which there is intentionally 
generated and/or used conductively coupled radio- frequency energy 
which is necessary for the internal functioning of the equipment 
itself. 

Class A equipment is equipment suitable for use in all 
establishments other than domestic and those directly connected to a 
low voltage power supply network which supplies buildings used for 
domestic purposes. 

This device complies with the requirements of CISPR11, Group 1, 
Class A as radiation professional equipment. Therefore, there may be 
potential difficulties in ensuring electromagnetic compatibility in 
other environments, due to conducted as well as radiated 
disturbances. 
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Operation is subject to the following two conditions: 

1 This device may not cause harmful interference. 

2 This device must accept any interference received, including 
interference that may cause undesired operation. 

If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try one or more of 
the following measures: 

1 Relocate the radio or antenna. 

2 Move the device away from the radio or television. 

3 Plug the device into a different electrical outlet, so that the device 
and the radio or television are on separate electrical circuits. 

4 Make sure that all peripheral devices are also certified. 

5 Make sure that appropriate cables are used to connect the device 
to peripheral equipment. 

6 Consult your equipment dealer, Agilent Technologies, or an 
experienced technician for assistance. 

Changes or modifications not expressly approved by Agilent 
Technologies could void the user’s authority to operate the 
equipment. 

ICES/NMB-001 

This ISM device complies with Canadian ICES-001. 

Cet appareil ISM est conforme à la norme NMB-001 du Canada. 

South Korean Class A EMC declaration 

A 급 기기 ( 업무용 방송통신기자재 ) 

This equipment is Class A suitable for professional use and is for use 
in electromagnetic environments outside of the home. 

 

이 기기는 업무용 (A 급 ) 전자파적합기기로서 판 매자 또는 사용자는 

이 점을 주 

의하시기 바라 며 , 가정외의 지역에서 사용하는 것을 목적으 로 
합니다 . 
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Site Preparation Requirements 

Prior to receiving your instrument you will have been provided with 
an Agilent 5100 ICP Optical Emission Spectrometer Site Preparation 
Guide, which describes the environmental and operating 
requirements of the ICP-OES system. You must prepare your 
laboratory according to these instructions before the ICP-OES can be 
installed. You should keep the Site Preparation Guide for future 
reference for example, if you plan to move your instrument. If you 
have misplaced your copy, you can obtain a free replacement from 
your local Agilent office.  

Position the equipment for easy access to the disconnecting switch 
on the left side of the instrument. 
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User Documentation 

You have been provided with the following documentation to help 
you set up and operate your Agilent ICP-OES system: 

 This User’s Guide, with safety practices and hazards information, 
instructions for finding information about installing and 
maintaining the components of the ICP-OES and a brief 
operation overview. 

 An extensive Help system containing context-sensitive Help, step-
by-step instructions for frequently performed operations and 
instructions for using any accessories you ordered. 

 A Familiarization DVD that includes information on how to set 
up methods and run instrument tests, some hardware basics and 
maintenance videos. 

Conventions 

The following conventions have been used throughout the 
documentation: 

 Menu items, menu options and field names (for example, click 
Copy from the Edit menu) have been typed in bold. Bold is also 
used to signify the buttons appearing throughout the software 
(e.g., click OK). 

 ALL CAPITALS indicate keyboard commands (e.g., press the F2 
key) and text you must type in from the keyboard (e.g., type 
SETUP at the prompt). 

Notes and tips 

A Note is used to give advice or information. 

A Tip is used to give practical hints to help you achieve the best 
possible performance from your ICP-OES. 
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Specifications 

The Agilent 5100 ICP-OES instrument is suitable for indoor use only 
and is classified suitable under Equipment class I category. 

Installation category 

The installation category is based on IEC61010:II. The installation 
category implies the regulation for impulse withstand voltage. It is 
also called the ‘Over voltage category’. ‘II’ applies to electrical 
equipment with detachable power cords. 

Pollution level 

The pollution level is based on IEC61010:2. Pollution level describes 
the degree to which a solid, liquid or gas that deteriorates dielectric 
strength is adhering. ‘2’ applies to a normal indoor atmosphere, 
where only non-conductive pollution occurs. 

Temperature control 

For optimum analytical performance, it is recommended that the 
ambient temperature of the laboratory be between 20 and 25 °C (68 
and 77 °F).and be held constant to within ±2 °C (±3.6 °F) throughout 
the entire working day. 

Environmental conditions 

See the Agilent 5100 ICP-OES Site Preparation Guide for 
specifications. 

Electrical Power Supplies 

For electrical specifications, refer to your Agilent 5100 ICP-OES Site 
Preparation Guide. 

All power supplies should be single phase AC, 3 wire system (active, 
neutral, ground or two active and ground) and should be terminated 
at an appropriate connection receptacle that is within reach of the 
system power cable. Use of power boards or extension cables is not 
recommended. 
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The installation of electrical power supplies must comply with the 
rules and/or regulations imposed by the local authorities responsible 
for the use of electrical energy in the workplace. 

Avoid using power supplies from a source that may be subject to 
electrical interference from other services (such as large electric 
motors, elevators, welders and air conditioning units). 

Circuit breaker 

NOTE For safety reasons, any internal fuse or circuit breaker is not operator accessible, 

and should only be replaced by Agilent-authorized personnel. 

 

The mains power switch contains a 20 A circuit breaker, which is 
reset when the power switch is cycled. 

If necessary, replace the power cord only with a cord equivalent to 
the one specified in the site preparation guide. 

Other Connections 

IEEE 802.3, Ethernet LAN cable 

Personal Computer Requirements 

The recommended and minimum PC specifications can be found in 
the Agilent 5100 ICP-OES Site Preparation Guide.  

Locate the PC keyboard and mouse for ergonomically correct access. 

Gas Supplies 

The installation of compressed or liquid gas supplies must comply 
with the rules and/or regulations imposed by the local authorities 
responsible for such use in the workplace. 
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Liquid or gaseous argon and nitrogen may be used with Agilent 
ICP-OES spectrometer systems. Agilent recommends the use of liquid 
gases, which are purer, more convenient and cheaper per unit 
volume. 

The main gas supply requirement is argon for supply to the plasma, 
nebulizer and optics interface purge. Gas is also required to purge 
the polychromator assembly, and this may be either argon or 
nitrogen. A separate gas line to the polychromator connects 
internally to the argon supply unless the optional nitrogen purge kit 
is fitted. Gas supply regulator pressure setting may need to be 
adjusted to ensure the pressure is in the permissible pressure range 
when delivering the gas flow demanded during operation. 

Table 1. Gas requirements 

 Argon Nitrogen 

Purity 99.996% 99.996% 

Oxygen  <5 ppm <5 ppm 

Nitrogen (argon only) <20 ppm - 

Water vapor <4 ppm <4 ppm 

Permissible pressure range* 500-600 kPa (73 to 88 psi) gauge 

Recommended pressure* 550 kPa (80 psi) gauge regulated 

*when supplying required gas flows 

Table 2. Typical flow rates for the Agilent 5100 ICP-OES instruments 

 Argon (with argon purge gas) Nitrogen (as purge gas) 

Instrument idle state 0.70 L/min Nitrogen flow 0.8 L/min 

Operational range  

(minimum-maximum, plasma on) 

9.1–31.8 L/min Argon flow 8.4–28.1 L/min 

Nitrogen flow 0.8–4.4 L/min 

Typical Flows   

Measuring wavelengths  

> 189 nm (poly boost off) 

14.65–20.65 L/min Argon flow 13.95–19.95 L/min 

Nitrogen flow 0.8 L/min 

Measuring wavelengths  

< 189 nm (poly boost on) 
19.25–25.25 L/min Argon flow 15.55–21.55 L/min 

Nitrogen flow 4.4 L/min 
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The spectrometer is supplied with three PVDF gas supply hose 
assemblies, 3 m (9.8 ft) in length. Gas supply adapters are included 
with each instrument to connect the instrument to regulated gas 
supplies. 

The user (or other authorized personnel) must carry out appropriate 
leak tests necessary to ensure safety on the gas and liquid 
connections that the operator is directed to assemble during 
installation, normal use or maintenance. 

Storage cylinder instructions 

Cylinders containing gas under pressure should be firmly secured to 
a rigid structure, and the storage area must be adequately ventilated. 

Never locate gas cylinders near a source of ignition, or in a position 
that is subject to direct heat. Gas storage cylinders often incorporate 
a pressure release device, which will discharge the gas at a 
predetermined temperature, usually around 52 °C (125 °F). 

If gases are to be plumbed from a remote storage area to the 
instrument site, ensure that the local outlets are fitted with stop 
valves, pressure gauges and suitable regulators, which are easily 
accessible to the instrument operator. 

Cryogenic liquids 

Cryogenic liquid gases are stored under pressure at very low 
temperatures in Portable Liquid Cylinders (PLCs). 

 

WARNING 

 
 

Extreme Cold Hazard 

Contact with the super-cold liquid, gas or pipe surfaces can cause severe 

skin damage. The PLCs should be located in a shielded position, and all 

piping should be routed or covered to prevent skin contact. 

 

For high gas flow rates and/or low ambient temperatures, it may be 
necessary to obtain sufficient gas pressure by passing the liquid 
through an external evaporator rather than use the internal pressure 
building facility of the PLCs. 
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Liquid argon and liquid nitrogen may not be stored for extended 
periods and often have special storage requirements. Contact your 
local authorities and cryogenic gas supplier for more detailed 
information on storage requirements and boil-off rates for local types 
of PLCs. 

Exhaust system 

The plasma operates at extremely high temperatures. The ICP-OES 
instrument exhaust fumes can be noxious or corrosive. 

The ICP-OES instrument exhaust must be directly connected to an 
exhaust system. The exhaust system must include an exhaust fan, be 
ducted to an external vent and provide a minimum flow of 
2.5 m3/min (88 ft3/min) at 2.4 m/s (7.7 ft/s) and a maximum flow of 
6.0m3/min (212 ft3/min) at 5.7 m/s (18.6 ft/s).  

The exhaust system installation must comply with any rules and/or 
regulations that may be imposed by the local authorities responsible 
for control of facilities and fixtures in the workplace. 

The exhaust fan should be located at least 2 meters (6 ft, 6 in) away 
from the top of the instrument chimney. The fan control switch and 
running indicator lamp should be located in a position where the 
instrument operator can view the indicator and access the control 
switch. 

 

WARNING 

 
 

Hot Surface 

The external vent may become hot during ICP-OES instrument operation and 

remain hot for some time after the instrument has been switched off. Allow 

the external vent to cool for at least five minutes before attempting to remove 

the exhaust hose. Use heat-resistant gloves. 
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ICP-OES instrument cooling air supply 

The ICP-OES instrument requires clean, dry, non-corrosive air for 
cooling purposes. This is supplied to the instrument through an air 
supply vent located at the top, left of the instrument. The vent has a 
dust filter, to filter out particulate matter. 

The air supply is used to cool the internal mechanical and electronic 
components of the instrument. Several of these assemblies contain 
parts prone to corrosion. The introduction of cooling air 
contaminated with high levels of acid vapors or other corrosive 
substances may cause damage to the instrument. 

Due to the corrosive nature of some analytical work, it is 
recommended that in applications demanding high usage of corrosive 
materials, an external cooling air supply system is provided. It is 
required that the cooling air be supplied from an environmentally-
controlled area that is away from the instrument exhaust and any 
other area where corrosive materials are stored or used. Do not duct 
humid, warm air into an instrument in a cooled laboratory 
environment. 

The cooling air system with flue, fan, ducting and supply cowl, must 
provide positive air pressure at the instrument inlet of 4 m3/min 
(141 ft3/min) when using the External Inlet Duct Adaptor Kit (G8010-
68002). The ducting should be corrosion-resistant and fire-proof. 

Water Cooling System 

Agilent ICP-OES instruments require a source of cooling water. Refer 
to the Site Preparation Guide for compatible water cooling systems. 

NOTE The operation manual, mounting and assembly hardware for the cooling system 

are included in the water cooler packaging. Care should be exercised to locate all 

of these articles before the pack is discarded. 
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NOTE Pressure regulation is recommended for supplies where the cooling water 

pressure may be subject to fluctuations. Pressure regulation is necessary for 

supplies that may exceed the maximum permissible pressure of 400 kPa (58 psi). 

 

The instrument is equipped with a water flow sensor, which will stop 
operation of the plasma if the cooling water flow through the 
instrument drops below 1.7 L/min (0.45 gpm). A second water flow 
sensor will stop the camera Peltier cooling assembly if the water flow 
through the instrument drops below 0.2 L/min (0.05 gpm). 

 

CAUTION Always ensure the water cooling system is on before igniting the plasma. 

 

Drain Vessel 

The Agilent ICP-OES system needs a drain vessel for disposal of 
excess fluids and vapors from the spraychamber or autosampler. 
Suitable tubing is supplied with the spectrometer for use with 
inorganic solvents. When using organic solvents, different drain 
tubing that is suitable for the solvent in use will be required. 

A chemically inert container, not glass or of a narrow-necked style, to 
hold a minimum of 2 liters (4 pints) of waste must be provided by the 
user. It should be located underneath the sample compartment (or on 
the right side of the instrument), where it is protected by the bench 
and in full view of the operator. 
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The Agilent 5100 ICP-OES must be installed by an Agilent-trained, 
Agilent-qualified or Agilent-authorized field service engineer. 

You should have completed and returned the form in the Site 
Preparation Guide stating that you have prepared the laboratory in 
accordance with the requirements detailed in that manual. An 
Agilent representative will then arrange a suitable installation date 
with you. 

Details for unpacking the instrument and what to do in case it has 
been damaged in transit are also outlined in the Site Preparation 
Guide. 
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Agilent 5100 ICP-OES Instrument Overview 

 

Figure 1. Front and side of the ICP-OES instrument 

1. Exhaust 8. Torch loader handle 15. Torch compartment handle 

2. Air inlet filter 9. Spraychamber 16. Water assembly 

3. Cone, radial and axial pre-

optics windows (not shown) 

10. Nebulizer 17. Optics purge filter for argon 

or nitrogen 

4. Snout 11. Peristaltic pump 18. Gas supply assembly 

5. Induction coil 12. Mains power button and 

cable connection  

19. Drain for liquid overflow 

6. Torch 13. Front panel power button  

7. Nebulizer and make up gas 

connections 

14. LED instrument status 

indicator 
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All connections of services to the ICP-OES instrument are made on 
the right side of the instrument, except for the mains power which is 
on the left side of the instrument. Remove the cover on the right side 
by hand to gain access to the Ethernet, accessory, water and gas 
connections. The Power on/off button is located on the front lower 
left side of the instrument and the mains power switch is located on 
the left back side of the instrument. 

 

Figure 2. Input and output connections on the side of the ICP-OES instrument 

 Item Description 

1 Accessory and LAN 

cable connections 

Agilent accessory connections and Ethernet cable for PC to 

instrument communication 

2 Argon gas inlet Argon gas inlet, standard 

3 Option gas inlet  Option gas (80% Ar/20% O2 mix) inlet, optional 

Nitrogen gas inlet, optional (not shown) 

4 Optics purge filter Argon or nitrogen gas filter 

5 Water outlet Connect to water chiller 

6 Water filter Coarse particulate water filter 

7 Water inlet Connect to water chiller 
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Instrument Status LED Color Coding 

The instrument status indicator light on the front top right of the 
Agilent 5100 ICP-OES displays different colors to represent the 
status of the instrument:  

 A green light indicates the following: 

 The instrument and software are connected and are ready to 
attempt a plasma ignition sequence, or 

 The instrument and software are connected and the plasma 
ignition sequence is underway, or 

 The instrument and software are connected, the plasma is lit 
and running and it is possible to run analysis of samples. 

 A yellow blinking light indicates the instrument and software are 
not connected (instrument is off-line). 

 A yellow light indicates that the instrument and software are 
connected, but the instrument is not ready to begin a plasma 
ignition sequence due to a tripped door or torch handle interlock, 
low gas pressure, low water flow or low cooling air flow. User 
intervention is required to resolve the problem. 

 A red light indicates an instrument firmware error causing a halt 
to analysis or restricting normal instrument operation. User 
intervention is required to resolve the problem. 

Front Power On/Off Switch 

The LED in the front on/off switch indicates the basic instrument 
on/off state. 

 Off indicates that the instrument is completely unpowered when 
the mains power switch on the left side of the instrument is also 
off. 

 Green flash once every 10 seconds indicates most of the 
instrument is unpowered, with the exception of the front panel 
Power on/off button switch sensing circuit inside the mains 
power module. Press the front panel Power on/off switch at the 
front to fully power up the instrument. 
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 Green blinking slow (1Hz). The mains power module is 
initializing and running through power up self-check, or is 
shutting off the instrument. 

 Green blinking fast (4Hz). Mains power module failed its 
initialization power-up self-check, instrument is unusable. The 
mains power supply is not adequate or the internal mains 
module needs to be replaced.  

 Green constantly on indicates the instrument has been switched 
on. 

ICP Expert Software 

The Agilent-trained, Agilent-qualified or Agilent-authorized field 
service engineer will install the ICP Expert software for you during 
the installation process. However, you may need to install the 
software yourself at some later stage, for example if you change the 
PC. Instructions are provided. 

There are several installation scenarios: 

 Standalone or network Flat File for Microsoft Windows 7  

 Standalone or network Database for 21 CFR Part 11 installations 
for Microsoft Windows 7 

 Upgrading Standalone or Network Database ICP Expert 
installations for Microsoft Windows 7  

 

Installation includes: 

 Installing the ICP Expert software 

 Installing the ICP Expert Help 

 Installing the LAN cable  

 Setting the instrument IP address 

 Installing and configuring SDA for 21 CFR Part 11 compliance 

 Installing and configuring SCM for 21 CFR Part 11 compliance 

 Completing a dark current scan and wavelength calibration 
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For instructions on how to install your ICP Expert software, refer 
to the documentation provided with your software: 

 ICP Expert Windows 7 64-bit (SP1) Software Installation 
Instructions 

 ICP Expert Software Installation Instructions for 21 CFR Part 11 
Environments for Windows 7 64-bit (SP1) only 

Once you have installed the appropriate software, connect the 
Ethernet cable, set the instrument IP address if necessary, and then 
perform the Detector Calibration and Wavelength Calibration.  

Connecting ICP Expert software to the ICP-OES 

To connect the software and instrument: 

1 Start the ICP Expert software by double-clicking on the desktop 
icon or from Start > All Programs > Agilent > ICP Expert > ICP 
Expert. 

2 Click Instrument. 

3 Click Connect. 

4 Enter the IP address of the instrument or select an existing 
instrument. 

5 Click Connect. 

6 Click Close. 

Performing a Detector and Wavelength Calibration  

To perform a dark current scan and wavelength calibration: 

1 Turn on the external exhaust.  

2 Start the ICP Expert software and open the Instrument Set-up 
Window. 

3 Connect the software to the instrument, if needed. 

a Click Instrument in the ICP Expert toolbar.  

b Click Connect. 

c Select the instrument from the list and the click Connect. 
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4 Ensure a standard glass concentric nebulizer, a double pass 
spray chamber and the appropriate plasma torch (for radial or 
dual view) are installed. Use manual sampling. The 
recommended peristaltic pump tubing is White/White for the 
pump and Blue/Blue for the drain. 

5 Ignite the plasma.  

6 Check that the Polychromator Boost purge is on. 

a On the ‘Instrument’ window of the ICP Expert software, click 
the Status tab and check that under the Polychromator 
section Boost is selected. 

b If the instrument was turned on from an idle state, the 
wavelength calibration in Steps 7-10 can be performed 
immediately. If the instrument was turned on after more than 
a few hours of being unpowered the polychromator can take 
several hours to stabilize the temperature and to purge. 

7 Aspirate a blank solution and then select the Calibration tab. 

8 Click Calibrate in the ‘Detector’ section. 

NOTE Once the detector calibration is completed, the date and time of the last 

successful calibration will be displayed, confirming the dark current 

measurement has been completed. 

 

9 Aspirate the wavelength calibration solution and then select the 
Calibration tab.  

10 Click Calibrate in the ‘Instrument’ section to perform a 
wavelength calibration. 

NOTE Once completed, the date and time of the last successful calibration will be 

displayed, a pass or fail mark will appear along with the wavelength error 

indicating whether the wavelength calibration is complete. 
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Saving and viewing the calibration data 

The calibration data is stored in the Logs. To view the data, export 
the Logs. 

1 From the main ICP Expert window, click File > Logs > Export 
Logs.  

2 Save the zipped Log file.  

3 Open the .zip file to view the Log files. 

NOTE The default save location is \Users\’Username’\Documents\Agilent\ICP 

Expert\Exported Results\ on the drive on which the ICP Expert software is 

installed. 

 

Hardware Components Replacement 

Your ICP-OES should be ready to operate after the Agilent field 
service engineer has installed it. However, you may need to set up 
items such as the peristaltic pump, nebulizer, torch or spraychamber. 
For instructions on how to do this, please refer to the 5100 ICP-OES 
Familiarization DVD or the ‘How to’ section in the ICP Expert Help.  

5100 ICP-OES torches 

Many of the 5100 ICP-OES torches are listed below, each with unique 
properties to suit a wide range of applications. Additional torches 
may be available. See the Agilent website for more information. 

 

Parameter 

Dual View Torches 
Dual view, large 

diameter injector 

Dual view torch 
Dual view torch 

demountable 
HF dual view torch 

High salt dual view 

torch 

Construction One piece 

Two piece 

demountable 

Two piece 

demountable 

Two piece 

demountable 

Injector diameter (mm) 1.8 1.8 1.8 2.4 

Injector material Quartz Quartz Ceramic Quartz 

Outer tube length Medium with slot Medium with slot Medium with slot Medium with slot 

Outer tube material Quartz Quartz Quartz Quartz 

Intermediate tube Quartz tulip Quartz tulip Quartz tulip Quartz tulip 
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Parameter 

Organics Radial View Torches 
Volatile Organics 

Torch 

Semi-volatile 

organics dual 

view torch 

Radial torch 

Radial 

demountable 

torch 

HF radial torch 

Radial volatile 

organics torch 

Construction 

Two piece 

demountable One piece 

Two piece 

demountable 

Two piece 

demountable 

Two piece 

demountable 

Injector diameter (mm) 1.4 1.4 1.4 1.8 0.8 

Injector material Quartz Quartz Quartz Ceramic Quartz 

Outer tube length Medium with slot Short (no slot) Short (no slot) Short (no slot) Short (no slot) 

Outer tube material Quartz Quartz Quartz Quartz Quartz 

Intermediate tube Quartz tulip Quartz tulip Quartz tulip Quartz tulip Quartz tulip 

Torch Assembly and Disassembly 

The demountable torch models allow the outer/intermediate tube set 
to be separated from the base/injector for easier cleaning. 

 

 

 

WARNING 

  

Hot Surface  

The torch and torch compartment become warm during instrument operation 

and remain so for some time after the plasma has been switched off. Allow 

the plasma compartment to cool for at least five minutes before accessing the 

plasma compartment. Allow the torch to cool for two minutes before touching 

the outer tube or attempting to dismantle the torch. 

WARNING 

  

Chemical Hazard 

Nitric and hydrochloric acids are very corrosive and can cause severe burns 

when they come into contact with the skin. It is essential that appropriate 

protective clothing be worn at all times when handling these acids. If acid 

contacts the skin, wash off with copious amounts of water and seek medical 

attention immediately. 
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CAUTION To prevent damage to the torch, always take care when handling or storing it.  

To prevent damage to the instrument, do not use the torch if it is damaged. 

 

 

Figure 3. Demountable torch where:  

1. Torch, 2. Torch securing ring and 3. Torch body 

Torch assembly 

To assemble the torch: 

1 Position the flat side of the torch securing ring so that it faces the 
top of the torch. 

 

Figure 4. Flat side of torch securing ring 

2 Slide the torch securing ring approximately 1/3 the way up the 
torch. 

3 

2 

1 
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Figure 5. Torch securing ring on torch 

3 Slide the torch into the torch body. 

 

Figure 6. Torch inserted into torch body 

 

4 Position the torch so that the groove on the torch body aligns 
with the left side of the hole in the torch. 

 

Figure 7. Torch alignment 
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5 Press the torch fully into the torch body and then press down on 
the torch securing ring. 

 

Figure 8. Torch inserted into torch body 

Torch disassembly 

To disassemble a two piece demountable torch: 

You may need a flat head screwdriver to loosen the securing ring if 
you cannot gently slide the torch out of the torch body by hand. 

1 Insert the screwdriver into the slot between the torch securing 
ring and the torch body. 

2 Gently twist the screwdriver to separate the torch securing ring 
from the torch body. 

 

Figure 9. Separating the torch securing ring from the torch body 

3 Repeat Steps 1 and 2 on the slot on the opposite side. 



 Installation 

Agilent 5100 ICP-OES User’s Guide 39 

4 Gently slide the torch out of the torch body. 

 

Figure 10. Removing the torch from the torch body 

5 Slide the torch securing ring off the torch. 

 
 

See Page 56 for the torch cleaning procedure. 

Accessories 

The following accessories may be available for use with your ICP-OES 
instrument: 

 SPS 3 Sample Preparation System 

 SVS 2 and SVS 2+ Switching Valve Systems 

 5 channel peristaltic pump 

 Air inlet dust filter 

 External inlet duct adapter 
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 Vapor generation accessory (VGA) 

 Multimode sample introduction system (MSIS) 

 Argon humidifier 

For safety and installation information, please see the accessory 
documentation or the ICP Expert Help. 

SPS 3 

For safety information and to prepare the Sample Preparation 
System (SPS 3) for installation, please see the instructions that came 
with the accessory. 

The SPS 3 is compatible with a wide range of commercially available 
low-cost autoclavable sample racks.  

Sample contamination from airborne particles is eliminated and 
corrosive or toxic fumes are removed during sampling with the 
optional environmental enclosure. 

SVS 2 and SVS 2+ 

For safety information and to prepare the accessory for installation, 
please see the instructions that came with the accessory. 

The SVS 2 and SVS 2+ increase sample throughput and decrease 
turnaround time and operating costs. The switching valves are 
positioned between the nebulizer and the peristaltic pump of the 
spectrometer. Samples are quickly loaded into the sample loop, ready 
for immediate analysis by the ICP-OES, greatly reducing sample 
uptake delays. Pre-emptive rinsing of the sample line means analysis 
times are reduced. The switching valve also features an internal T-
piece within the valve, reducing dead volume and providing online 
addition of internal standard and ionization buffer solutions. A 
bubble injector automatically injects bubbles after the sample is 
loaded into the loop, isolating the sample from the rinse solution. 
This reduces the volume of sample required for measurement as 
tailing (or dilution) effects are minimized. 
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5-channel Peristaltic Pump 

The five channel peristaltic pump can be used for additional solution 
introduction and is required when using the MSIS accessory. 

External Inlet Duct Adapter  

The External Inlet Duct Adapter provides an attachment for ducting 
air into the air intake port, for use in labs with harsher 
environments. 

Air inlet dust filter 

The air inlet dust filter provides fine dust filtration of the air drawn 
into the air intake port.  

Vapor Generation Accessory (VGA) 

The VGA 77P is a continuous flow vapor generation accessory for 
Inductively Coupled Plasma-Optical Emission Spectroscopy 
(ICP-OES) instruments that determines Hg and the hydride-forming 
elements at parts per billion (ppb) levels. The entire plumbing 
assembly is integrated into a separate module and can be simply 
exchanged when switching elements. 

Multimode Sample Introduction System (MSIS) 

For safety information and to prepare the MSIS for installation, 
please see the instructions that came with this accessory and the ICP 
Expert Help. 

The MSIS is used with the ICP-OES instrument to provide 
simultaneous vapor generation of several hydride forming elements, 
enabling determination with low ppb detection limits. 

The MSIS consists of a nebulizer and modified glass cyclonic spray 
chamber that has two vertical conical tubes in the center of the 
chamber. This allows for reductant and sample to mix quickly and 
thoroughly in the chamber using thin film hydride technology to form 
the hydrides. 
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The MSIS can be operated in three modes: hydride only, 
simultaneous hydride and conventional nebulization or conventional 
nebulization only. 

Argon Humidifier 

The Argon Humidifier is commonly used when running aqueous 
samples with high dissolved solids or high dissolved salt content. 
When using the accessory, the nebulizer gas flow is passed through 
the humidifier to increase the water vapor in the gas. This has been 
found to be beneficial by reducing the build-up of salt and other 
dissolved solids in the sample introduction system. By reducing 
blockages, the Argon Humidifier helps to ensure uninterrupted, 
maintenance-free operation. 
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This chapter provides a quick guide to getting the instrument set up 
and running samples. 

You will find step-by-step instructions for common operations in the 
ICP Expert Help. To access this information: 

1 Select the Windows Start button and choose Programs > Agilent 
> ICP Expert > ICP Expert Help. 

2 When the ICP Expert Help appears, click How to to view the 
available step-by-step instructions. 

Analysis Checklist 

You need to complete the following steps in turn to measure a 
sample/s. You will find information on each step in this chapter. 

 Turn on the PC, instrument and software 

 Connect the software to the instrument 

 Prepare for analysis 

 Perform a dark current scan and wavelength calibration 
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 Create/open a worksheet 

 Develop a method 

 Run samples 

 Print a report 

Turning On the Instrument and Software 

Before starting the system, carefully read the Safety practices and 
hazards section at the front of this manual and ensure that the 
laboratory is set up according to the details specified in the Site 
Preparation Guide. 

Turning on the instrument for the first time (or from long term 

shutdown) 

To turn on the instrument for the first time or from shutdown: 

1 Check that the exhaust and intake lines are secured to the 
ICP-OES instrument, and that the air filter is not blocked. 

2 Turn on the laboratory exhaust system. 

3 Ensure the gas and water lines are connected to the ICP-OES 
instrument 

4 Switch on the water cooler. 

5 Turn on the gas supply. 

6 Ensure that the gas and water supplies are turned on and set to 
the correct pressures, and that the water cooler is set to the 
correct temperature. 

7 Check that the torch is clean and in good condition, and installed 
with the torch handle fully closed. 

8 Check that all tubing on the spraychamber, nebulizer and 
peristaltic pump is installed and correctly connected. 

9 Check that the plasma compartment door is fully closed. 

10 Check that the Ethernet LAN cable is connected to the computer 
or Local Area Network. 

11 Switch on the computer, monitor and printer. 

file:///C:/Documents%20and%20Settings/lspangle/Local%20Settings/Temporary%20Internet%20Files/Content.Outlook/safety/SafetyHome.htm
file:///C:/Documents%20and%20Settings/lspangle/Local%20Settings/Temporary%20Internet%20Files/Content.Outlook/safety/SafetyHome.htm
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12 Plug the ICP-OES cable into the wall socket and set the mains 
power switch on the left side of the instrument to ‘On’.  

13 Press the Power on/off switch on the front of the instrument. The 
LED will display green when it is on. The 5100 ICP-OES is now in 
the idle state, which continually purges and thermostatically 
controls the polychromator. 

NOTE Both the mains power switch on the left side of the instrument and front panel 

power switch must be on for the instrument to work. 

 

14 To start the ICP Expert software, click Start > All Programs > 
Agilent > ICP Expert > ICP Expert or double-click the ICP 
Expert desktop icon. The Main Index window will appear. 

Running the instrument from an idle state 

During an idle state (both power switches are ‘On’), the 
polychromator temperature is regulated and polychromator gas 
purge is running to ensure the instrument is ready for analysis 
within 20 minutes after lighting the plasma. 

To begin using the instrument from an idle state: 

1 Turn on the laboratory exhaust system. 

2 Check that the torch is clean and in good condition, and installed 
with the torch handle fully closed. 

3 Check that all tubing on the spraychamber, nebulizer and 
peristaltic pump is correctly connected. 

4 Check that the torch compartment door is fully closed. 

5 Switch on the monitor and printer (if they are off). 

6 Switch on the water cooler (if it is off).  

7 If you have accessories fitted, switch them on. 
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Preparing for Analysis 

To prepare for analysis: 

1 Click the Plasma button in the ICP Expert software. 
Alternatively, press F5 or choose Plasma on from the arrow 
under the Plasma button.  

NOTE The plasma ignition sequence will take up to 60 seconds to complete. If the 

plasma fails to ignite, refer to the Troubleshooting section in the Help for further 

information.  

 

NOTE For optimum performance and stability, for the ICP-OES instrument a warm up 

time of 20 minutes is recommended after igniting the plasma.  

If using wavelengths below 189 nm: purging the polychromator can take up to 

several hours. The polychromator thermal stabilization can take up to several 

hours from long term shutdown. 

 

2 Ensure that the peristaltic pump is correctly set up (refer to the 
Peristaltic Pump section of the 5100 ICP-OES Familiarization 
DVD or the ICP Expert Help). If you have not already done so, 
adjust the pressure bars on the peristaltic pump for even sample 
flow and drainage. 

3 Place the sample tubing from the peristaltic pump into the rinse 
solution and the drain tubing into the drainage vessel. 

4 Click the Pump button in the ICP Expert software and choose 
Normal (15 rpm) from the arrow under the Pump button. The 
pump will be initialized and the solution will begin aspirating.  

Performing a Detector and Wavelength Calibration  

See Page 32 for instructions. 
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Creating/Opening a Worksheet 

Creating a new worksheet 

To create a new worksheet, click New from the Start page or the File 
menu.  

A list of recently used files will be presented when creating a new 
worksheet from a template; otherwise you may Browse for more files. 
The ‘New From Template’ dialog box will be displayed in this 
instance. 

Opening an existing worksheet 

To open an existing worksheet: 

1 Click Open from the Start page or from the File menu.  

2 A list of recently used files will be displayed. Otherwise, you may 
Browse for more files. The ‘Open’ dialog box will be displayed in 
this instance. 

Creating a new worksheet from a template 

To create a new worksheet from a template click New From on the 
Start page or New From Template from the File menu.  

A list of recently used files will be presented, otherwise you may 
Browse for more files. The New From Template dialog box will be 
displayed in this instance. 

The Worksheet window will appear with the new worksheet loaded. 

Developing a Method 

To develop a method: 

1 Open a new worksheet or one from a template. 

2 On the ‘Elements’ page, select the element(s) from the ‘Element’ 
drop-down box or type the element name or symbol and then 
perform one of the following:  

 Click  to add the primary wavelength for the selected 
element.  
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 Highlight the wavelength you wish to use from the list of 
available wavelengths displayed. Click Add.  

NOTE Alternatively, press CTRL and select the element from the periodic table to add 

the primary wavelength for the selected element to your method. 

The element will appear in the table with the selected wavelength 
and default settings selected. 

3 Check that there are no known interferents or other analytical 
lines close to the selected analytical line. Their relative intensity 
will govern how close the lines can be to each other. For example, 
if your matrix contains an element that is not of analytical 
interest, but is a potential interferent and has a line close to one 
of your analytical lines, the concentration of that element in your 
matrix will determine whether you need to choose another 
analytical line.  

4 Make any required adjustments to each element including 
selecting a different wavelength, entering additional information 
into the ‘Label’ column, and selecting the type (choose from 
analyte, internal standard or interferent).  

5 Enable QC and/or IEC if these features are going to be used. 
(Rate QC is only available in ICP Expert Pro software.)  

6 Click Conditions to modify both common settings for the run and 
settings for each element. Up to four different measurement 
conditions can be used. 

7 Click QC to enter the method detection limits, select the QC tests 
to be used and which error actions should be performed if an 
error occurs. 

8 Click IEC to enter the concentration of the elements in your 
analyte and interferent standards. 

9 Click Standards to enter the concentration of the elements in 
your standards and select whether to use other options such as 
Standard Additions or MultiCal. In addition, also select whether 
to use the blank in calibrations and whether to enable reslope. 

10 Click Sequence to specify the number of samples, insert QC tests, 
select the solution type, edit the sample labels and end of run 
actions. 
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11 Click FACT to manually create FACT models or to set the 
method up to automatically create them during analysis. 

12 If you are using an autosampler, click the ‘Autosampler’ tab to 
select the racks and probe depth (if needed). Depending on the 
autosampler selected, options may vary. 

NOTE See the ICP Expert Help for a more detailed description of setting up a method. 

Running Samples 

To run samples: 

1 Set up the autosampler with all solutions, if required. 

2 Click the Analysis tab and do the following: 

a Ensure your samples are selected. This will be indicated by a 
check next to the Rack:Tube column. To select all solutions, 
select the checkbox next to the Rack:Tube title. 

 

 

b Click the Run icon in the toolbar (or press the SHIFT+F8 
keys) to begin the analysis, and follow the prompts. 

NOTE For further information about running an analysis, refer to the ICP Expert Help. 

Printing a Report 

To print a report: 

1 Click Report on the toolbar or File > Report. 

2 Choose whether you want to print or preview the report or save 
the report as a PDF file. 
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TIP Previewing the report allows you to ensure that you have included all of the 

data you require. 

 

3 Select a report template and then click Open. 

4 Click the Print button to generate a report as specified. A 
message will appear briefly indicating the progress status of the 
report being generated. 

5 The Print dialog box will then be opened. You can select to print 
all of the report, or a range of pages. Reports are printed to your 
default printer, unless you specify otherwise. You can specify 
your printer options in the Print Setup dialog box, accessible 
from the File menu. 

Instrument Idle State 

In between routine use, it is recommended the instrument be left in 
the idle state, which is when the instrument is fully powered but the 
plasma off. In this state the polychromator thermostating system and 
purge systems remain operational, and the internal air cooling 
system runs at reduced capacity. If the ICP-OES is not going to be in 
use for a prolonged period of time, fully shutdown the instrument 
(which turns off all purging as well as the polychromator 
thermostating system). 

Setting the instrument to idle 

To put the instrument into an idle state: 

1 Rinse the spraychamber by aspirating water for a few minutes. 

NOTE When running organic samples it is recommended that the spraychamber be 

cleaned and dried thoroughly between analyses. 

 

2 Extinguish the plasma by clicking the Plasma Off icon, pressing 
SHIFT + F5 on the keyboard or choosing Plasma Off from the 
Analyze menu. The peristaltic pump stops automatically when 
the plasma is extinguished. 

file:///C:/Documents%20and%20Settings/lspangle/Local%20Settings/Temporary%20Internet%20Files/Content.Outlook/XL9VXH8F/InstrumentOff.htm%23Shutdown
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3 To save on argon costs, you can turn the polychromator boost off 
overnight, by deselecting Polychromator > Boost on the Status 
tab on Instrument window. This is not recommended if you are 
routinely analyzing lines below 190 nm, as the instrument will 
take some time to stabilize when the polychromator boost is 
turned on again. 

4 To increase the pump tubing lifetime, loosen the peristaltic pump 
tubes by releasing the pressure bars and lift the tubes out of the 
grooves. To do this: 

a Push up the pressure bar screws. This releases them from the 
pressure bar (refer to Figure 11). 

b Allow the pressure bar to swing downwards. 

c Lift the tubing out of the grooves. 
 

 

Figure 11. Peristaltic pump with pressure bar screws pushed up and 

pressure bar freely down, allowing tubing to be loosened 

5 Switch off the water cooler. 

6 Close the worksheet by clicking ‘Close’ from the ‘File’ menu but 
leave the ICP Expert software running. You may switch off the 
printer, monitor and any accessories if desired.  

Ensure that the Powersave option on your PC is disabled (this will 
prevent the shutdown of your hard disk). If this option is not 
disabled, you could lose data during an unexpected shutdown. 
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WARNING 

 

Noxious Fumes 

Inhalation danger. The exhaust system MUST remain on if the gas supplies 

are on. 

 

Turning off the instrument for long term shutdown 

To shut down your instrument completely: 
 

CAUTION The ICP-OES gas control unit supplies uninterrupted gas purge to the 

polychromator assembly during the run and idle states only to minimize the 

ingress of moisture. It is recommended that both the instrument and gas 

supplies be left on at all times except during long periods of non-use. 

 

1 Follow Steps 1-6 of the idle state procedure. 

2 Switch off any accessories (where applicable), and then shut 
down the argon gas supply at the cylinder.  

3 Switch off the Power at the front lower left of the instrument. 

4 Switch off the mains power switch on the left side of the 
instrument. This will turn off the complete instrument as well as 
the polychromator thermostating system. 

5 Turn off the laboratory exhaust system. 

6 Exit the ICP Expert software, if it is no longer required, by 
choosing Exit from the File menu. Switch off the printer and 
monitor. 

Restarting the instrument to be ready for analysis again will take 
several hours due to the gas purge and polychromator thermal 
stabilization time. 

NOTE If the instrument is not going to be in use for a period of time the torch, cone, 

snout and torch compartment should be cleaned of any deposits, dirt or residue. 

Check the cleanliness of the removable axial window when cone is removed. 
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This chapter includes the Agilent 5100 ICP-OES maintenance 
requirements that may be carried out by an operator. Any 
maintenance procedures not specifically mentioned in this chapter 
should be carried out only by Agilent-trained, Agilent-qualified or 
Agilent-authorized field service engineers. 

 

WARNING 

 
 

Eye Hazard 

Danger to eyes. The plasma is an intense light source. Direct viewing of the 

light source will cause eye damage. Operators and other unauthorized 

personnel must NEVER remove the main covers or disable the safety interlock 

system. 

 

WARNING 

 
 

Shock Hazard 

This instrument contains electrical circuits, devices and components 

operating at dangerous voltages. Contact with these circuits, devices and 

components can result in death, cause serious injury, or painful electrical 

shock. 
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WARNING 

 
 

RF Hazard and Hot surfaces 

The plasma radiates dangerous levels of radio frequency (RF) energy. 

Exposure to the RF energy can cause severe skin damage and cataracts of 

the eyes, while close contact with the operating plasma can result in severe 

heat burns to the skin, and an electrical discharge which can jump a 

considerable distance and may cause death, severe electric shock or sub-

surface skin burns. 

 

NOTE This section refers to maintenance procedures for the ICP-OES instrument. You 

should refer to your PC and printer manuals for their maintenance procedures, 

and to the ICP Expert Help for the maintenance procedures for any accessories 

you ordered. 

Routine 

The following parts of the ICP-OES, consumables and accessories 
require routine maintenance. Maintenance instructions are included 
in the 5100 ICP-OES Familiarization DVD and the ICP Expert Help. 
To access these instructions, click the Maintenance tab on the DVD or 
click Start > All Programs > Agilent > ICP Expert > ICP Expert 
Help. Click the Maintenance link. 

Hourly 

 Check and, if necessary, empty the drain vessel. 

Daily  

 Check the water level in the Argon Humidifier before every use 
(if applicable).  

 Clean the surface of your ICP-OES (spills should be cleaned up 
immediately). 

 Inspect the pump tubing and replace if it is flat or has lost its 
elasticity. Unclip the pump tubes when the pump is not in use. 

  

file:///C:/Documents%20and%20Settings/lspangle/Local%20Settings/Temporary%20Internet%20Files/Content.Outlook/XL9VXH8F/DrainVesselMaintenance.htm
file:///C:/Documents%20and%20Settings/lspangle/Local%20Settings/Temporary%20Internet%20Files/Content.Outlook/XL9VXH8F/CleaningVista.htm
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Weekly 

 Clean the torch.  

 Clean the cone  

 Clean the snout. 

 Clean the spraychamber. 

 Clean the nebulizer. 

Monthly 

 Inspect the removable axial and radial pre-optics windows for 
cleanliness. Clean or replace as necessary. 

 Clean the cooling air intake filter on top of your instrument. 

 Inspect the state of the induction coil. Some discoloration is 
expected, however, extensive discoloration may indicate 
servicing is required. Contact your local Agilent office or 
representative if maintenance is required. See the following 
section for additional information. 

 Remove and clean the water filter on the right side of the 
instrument. 

 Check the water level in the water cooler (refer to the manual 
supplied with the water cooler for details). 

 Check/clean the heat exchanger (radiator) on the cooling system 
to remove any build-up of dust and dirt. 

 Periodically, drain the coolant from the cooling system and then 
refill/ treat with an appropriate algaecide (as recommended by 
the manufacturer). 

 Perform a wavelength calibration.

 Inspect the external gas supply system for leaks including the 
tubing connected to the instrument. Replace any damaged, 
leaking or worn components. 

file:///C:/Documents%20and%20Settings/lspangle/Local%20Settings/Temporary%20Internet%20Files/Content.Outlook/XL9VXH8F/CleaningTorch.htm
file:///C:/Documents%20and%20Settings/lspangle/Local%20Settings/Temporary%20Internet%20Files/Content.Outlook/XL9VXH8F/CleaningConeAxial.htm
file:///C:/Documents%20and%20Settings/lspangle/Local%20Settings/Temporary%20Internet%20Files/Content.Outlook/XL9VXH8F/Snout.htm
file:///C:/Documents%20and%20Settings/lspangle/Local%20Settings/Temporary%20Internet%20Files/Content.Outlook/XL9VXH8F/SprayChamber.htm
file:///C:/Documents%20and%20Settings/lspangle/Local%20Settings/Temporary%20Internet%20Files/Content.Outlook/XL9VXH8F/Nebulizer.htm
file:///C:/Documents%20and%20Settings/lspangle/Local%20Settings/Temporary%20Internet%20Files/Content.Outlook/XL9VXH8F/Filters.htm%23Cooling_air_intake_filter
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Cleaning 

Any spills in the sample compartment should be wiped up 
immediately.  

The user (or other authorized personnel) must perform the 
appropriate decontamination procedure if hazardous material is 
spilled on or inside the ICP-OES. 

The exterior surfaces of the ICP-OES should be kept clean. All 
cleaning should be done with a soft cloth. If necessary, this cloth can 
be dampened with water or a mild detergent. Do not use organic 
solvents or abrasive cleaning agents. 

Before using any cleaning agent, procedure or decontamination 
method except those specified by Agilent, the user (or other 
authorized personnel) should check with your local authorized 
Agilent field service engineer or representative to confirm that the 
proposed method will not damage the equipment.  

Torch Cleaning 

Acid cleaning of the torch 

See Page 35 for demountable torch disassembly instructions. 
  

WARNING 

 

 

Hot Surface and Chemical Hazard 

The torch and torch compartment become hot during instrument operation 

and remain hot for some time after the instrument has been switched off. 

Allow the torch and torch compartment to cool for at least five minutes before 

attempting to remove the torch. Use heat-resistant gloves.  

Nitric and hydrochloric acids are very corrosive and can cause severe burns 

when they come into contact with the skin. It is essential that appropriate 

protective clothing be worn at all times when handling these acids. If acid 

contacts the skin, wash off with copious amounts of water and seek medical 

attention immediately. 
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Figure 12. Torch components where 1. Ball joint, 2. Gas ports, 3. Torch securing 

ring (demountable torch only), and 4. Torch outer tube 

To clean the torch: 

1 Soak the quartz parts of the torch in 50% aqua regia (1 part water 
to 1 part aqua regia) for at least 1 hour. To make aqua regia 
combine 1:3 concentrated nitric acid: hydrochloric acid. The 
length of time required for the cleaning procedure will depend 
upon the extent of the contamination. Do not leave the torch in 
the acid for longer than 8 hours. 

IMPORTANT For one-piece torches: use a clean, wide diameter, open-top beaker or a similar 

container to hold the torch inverted while soaking in acid.  

For two-piece demountable torches: Use a large enough beaker or similar 

container to fully submerge the torch quartz tube. 

Use clean/particle free acid to perform the soak. 

2 One-piece torches: Place the torch in the vessel so that the acid 
covers the quartz to just below the plastic base. See Figures 13A 
and 14. To remove build up from the lower part of the injector, 
pipette some of the acid through the ball joint of the injector. See 
Figure 12. 

Two-piece demountable torches: The quartz outer tube set can 
be fully immersed in acid. See Figures 13B, 13C and 14. The 
injector can be inverted and dipped in the acid to just before the 
plastic base.  

1 

2 

3 

4 
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CAUTION Avoid acid contact with the seal where the quartz meets the plastic base. 

Damage to the seals and torch body may occur. 

 

3 Keep the one piece torch inverted through all the cleaning and 
rinsing steps unless otherwise directed.  

    

Figure 13. A. Bonded torch in acid and B. demountable torch body with injector 

in the acid, C. Torch outer tube in acid. A and B placed in an open vessel with 

acid level just below the plastic base. 

 

Figure 14. Close up of torch placed in vessel, highlighting acid level relative to 

the plastic base 

  

A B C 

A B C 
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Rinsing the torch 

To rinse bonded torches: 

1 Hold the torch with the ball joint connector at the top.  

2 Thoroughly flush the inside and outside of the torch with 
deionized water (18 MΩ.cm) using a wash bottle to direct the 
water stream. See Figure 14A and B. 

3 Invert the torch (see Figure 14C) so that the quartz tubes are at 
the top and the ball joint connector is at the bottom. Direct rinse 
water through the quartz tubes so that the water flows out of the 
gas entry ports and ball joint connector for at least 30 s. 

     

Figure 15. A. Rinsing the torch upper gas supply port. B Close-up shows rinsing 

through the upper gas supply port. C. Torch shown inverted. 

To rinse demountable torches: 

1 Thoroughly flush the inside and outside of the torch quartz 
components, including through the gas holes, with deionized 
water (18 MΩ.cm) using a wash bottle to direct the water stream.  

Drying the torch 

Oven drying is not recommended. It is not as effective at removing 
moisture as using compressed air or nitrogen. 

To dry bonded torches:  

1 Hold the torch inverted (with the ball joint connector at the top). 
See Figure 15A. 

A B C 
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2 Blow clean compressed air or nitrogen through the three gas 
supply ports (two on the base and through the ball joint 
connector) to remove moisture.  

3 Ensure that all moisture is removed before refitting the torch 
into the instrument. 

                

Figure 16. A. Drying the torch upper gas supply port. B Close-up shows drying 

through the lower gas supply port. C. Close-up shows drying through ball joint. 

To dry demountable torches: 

1 Blow clean compressed air or nitrogen through the quartz tube, 
injector, torch body and the three gas holes (see Figure 16) to 
remove moisture.  

2 Ensure that all moisture is removed before reassembling the 
torch. 

Additional checks after cleaning 

Perform the following checks after cleaning: 

1 Inspect the torch for damage such as loose fitting of the quartz 
tubes in the plastic base, holes or significant cracks. If any 
damage is found, replace the torch immediately. 

2 Check for carry-over after refitting the torch to the instrument to 
determine if the cleaning procedure has been sufficient. If carry-
over is found, repeat the cleaning process. 

3 Replace the torch when the outer surface of the quartz outer tube 
is rough to the touch (which indicates signs of wear), or if there 
are any cracks visible.  

A B C 
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NOTE 
Long term exposure to acid during cleaning may lead to discoloration of the 

plastic base. This change is cosmetic only and should not impact performance if 

the torch is clean and the results of the other torch checks are satisfactory. 

Store the torch in the original box or a plastic bag when not in use. 

Troubleshooting 

For troubleshooting information, please see the ICP Expert Help: 

1 Click Start > All Programs > Agilent > ICP Expert > ICP Expert 
Help. 

2 When the ICP Expert Help appears, click Troubleshooting to 
view instructions on how to troubleshoot. 
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Spare Parts 

For spare parts and consumables ordering information, refer to the 
Agilent Technologies website: 

www.agilent.com 

To replace the items listed below, you must use Agilent-
manufactured parts, which can be ordered online from the Agilent 
website or through your local sales representative. 

The following is a list of recommended spares to keep on hand to 
minimize downtime during maintenance and repairs: 

 Torch 

 Air inlet filter (basic) 

 Air inlet filter (dust filter) 

 Axial pre-optic window 

 Radial pre-optic window 

 Spray chamber 

 Nebulizer 

 Peristaltic pump tubing 

 Drain tubing 

Technical Support 

For technical support contact information, refer to the Agilent 
Technologies website for details: 

www.agilent.com 
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